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1.  Introduction  

 

1.1.  Scope 

This document describes the installation and handling of the iCOR plugin for the Sentinel-2 SNAP 

toolbox. 

1.2.  Objectives 

The plugin allows users to test and perform an iCOR atmospheric correction for  

- Landsat-8 and Sentinel2 data 

- Land, inland and coastal waters 

1.3.  Background 

iCOR (De Keukelaere et al., 2018, Sterckx et al., 2015) is a scene and sensor generic atmospheric 

correction algorithm that can handle land and water targets (Pahlevan et al., 2021) and is 

adaptable with minimal efforts to other hyper- or multi-spectral sensors. All input data required 

for the atmospheric correction are derived from the image itself or delivered through pre-

calculated look-up-tables. Through the use of a single atmospheric correction implementation, 

discontinuities in the reflectance between land and the highly dynamic water areas are reduced. 

The workflow of iCOR is depicted in Figure 1.  In short following steps are run through: (i) land 

and water pixels are identified (ii) land pixels are used to derive Aerosol Optical Thickness (AOT) 

based on an adapted version of the method developed by (Guanter, 2007) (iii) an adjacency 

correction is performed using SIMEC (Sterckx et al., 2014) over water and fixed background 

ranges over land targets, and (iv) the radiative transfer equation is solved. iCOR uses MODTRAN 

5 (Berk et al., 2006) Look Up Tables (LUT) to perform the atmospheric correction and needs 

information about the solar and viewing angles (Sun Zenith Angle (SZA), View Zenith Angle (VZA) 

and Relative Azimuth Angle (RAA)) and a digital elevation model (DEM).  
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Figure 1 Workflow of iCOR atmospheric correction. LUT = Look-up-Table, SZA = Solar Zenith Angle, VZA 

= View zenith anhle, RAA = relative azimuth angle, DEM = Digital Elevation Model, TOA = Top-Of-

Atmopshere, AOT = Aerosol Optical Thickness, SIMEC = Similarity Environment Correction (Sterckx et 

al., 2014), L2 = Level 2 atmospherically corrected. 

 

1.4.  Version 3.1 updates  

We find it important to keep improving the performance of iCOR and to expand the 

embedded functionalities.  The iCOR SNAP Version 3.1 plug-in is made compatible with 

latest SNAP 12.0 version and latest Sentinel-2 L1C processing baselines include the 

following improvements: 

• Update to support SNAP 12 

• Python upgraded to version 3.12 

• Installation as user without administrative privileges under Windows 

• Sentinel-2C support 

• Sentinel-2 L1C latest processing baselines which includes a 

radiometric_offset (i.e.   processing baselines 04.00 and higher)       

1.5.  Reader level 
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This document is written for SNAP Toolbox users. The document assumes that the reader is 

familiar with the basic concepts in the SNAP software and its integrated processors.  

1.6.  Notion 

The iCOR plugin for the SNAP toolbox is provided as an experimental tool for research 

purposes. The use of the tool is at own discretion and risk. 

1.7.  Acronyms 

AOT Aerosol Optical Thickness 

BOA Bottom-of-Atmopshere 

DEM Digital Elevation Model 

iCOR Image Correction (De Keukelaere et al., 2018) 

SIMEC Similarity Environment correction (Sterckx et al., 2014) 

TOA Top-Of-Atmosphere 

VITO Vlaams Instituut voor Technologisch Onderzoek 

1.8.  References 

Bassani, C.; Sterckx, S. Calibration of Satellite Low Radiance by AERONET-OC Products and 6SV 

Model. Remote Sens. 2021, 13, 781. https://doi.org/10.3390/rs13040781 

De Keukelaere, L., Sterckx, S., Adriaensen, S., Knaeps, E., Reusen, I., Giardino, C., Bresciani, M., 

Hunter, P., Neil, C., Van der Zande, D.,  Vaiciute, D. (2018) Atmospheric correction of 

Landsat-8/OLI and Sentinel-2/MSI data using iCOR algorithm: validation for coastal and 

inland waters, European Journal of Remote Sensing, 51:1, 525-542, DOI: 

10.1080/22797254.2018.1457937 

Guanter, L., 2007. New algorithms for atmospheric correction and retrieval of biophysical 

parameters in earth observation. Application to ENVISAT/MERIS data. 

Guanter, L., Alonso, L., Moreno, J., Member, A., 2005. A Method for the Surface Reflectance 

Retrieval From PROBA / CHRIS Data Over Land : Application to ESA SPARC Campaigns 43, 

2908–2917. 

Pahlevan, N., A. Mangin, S. V. Balasubramanian, et al. 2021. "ACIX-Aqua: A global assessment of 

atmospheric correction methods for Landsat-8 and Sentinel-2 over lakes, rivers, and 

coastal waters." Remote Sensing of Environment, 258: 112366 

[10.1016/j.rse.2021.112366] 



   ICOR PLUGIN FOR SNAP TOOLBOX 

  SOFTWARE USER MANUAL 

  VERSION 3.1 

COPYRIGHT © 2025 VLAAMSE INSTELLING VOOR TECHNOLOGISCH ONDERZOEK (VITO) PAGE 6 

Richter, R., Schläpfer, D., Müller, A., 2006. An automatic atmospheric correction algorithm for 

visible/NIR imagery. Int. J. Remote Sens. 27, 2077–2085. doi:10.1080/01431160500486690 

Sterckx, S., Knaeps, E., Adriaensen, S., Reusen, I., Keukelaere, L. De, Hunter, P., 2015. Opera : an 

Atmospheric Correction for Land and Water. Proc. Sentin. Sci. Work. 3–6. 

Sterckx, S., Knaeps, S., Kratzer, S., Ruddick, K., 2014. SIMilarity Environment Correction (SIMEC) 

applied to MERIS data over inland and coastal waters. Remote Sens. Environ. 

doi:10.1016/j.rse.2014.06.017 

Sterckx, S.; Wolters, E. Radiometric Top-of-Atmosphere Reflectance Consistency Assessment for 

Landsat 8/OLI, Sentinel-2/MSI, PROBA-V, and DEIMOS-1 over Libya-4 and RadCalNet 

Calibration Sites. Remote Sens. 2019, 11, 2253. https://doi.org/10.3390/rs11192253 

Vermote, E.F., Tanré, D., Deuzé, J.L., Herman, M., Morcrette, J.J., 1997. Second simulation of the 

satellite signal in the solar spectrum, 6s: an overview. IEEE Trans. Geosci. Remote Sens. 35, 

675–686. doi:10.1109/36.581987 

 

  



   ICOR PLUGIN FOR SNAP TOOLBOX 

  SOFTWARE USER MANUAL 

  VERSION 3.1 

COPYRIGHT © 2025 VLAAMSE INSTELLING VOOR TECHNOLOGISCH ONDERZOEK (VITO) PAGE 7 

2.  Software installation  

2.1.  Hardware requirements 

20 GB of free disk space of which: 

• 1.2 GB for ESA-SNAP Toolbox installation 

• 7 GB for iCOR installation 

• Extra space for intermediate files during processing 

2.2.  Software requirements 

OS : 

• Window  8 or higher (64bit) 

• Linux: Ubuntu 24.04 (LTS) 

 

General : 

• SNAP 12.0.0 –  https://step.esa.int/main/download/snap-download/  

 

Windows: 

• Windows redistributables (2022)  https://aka.ms/vs/17/release/vc_redist.x64.exe 

• When installing ESA-SNAP make sure the option “Extend my PATH environment 
variable” is selected 

 

Ubuntu: 

• Installation of python packages: 
sudo apt install python3-rasterio 
sudo apt install python3-pyproj 

https://step.esa.int/main/download/snap-download/
https://aka.ms/vs/17/release/vc_redist.x64.exe
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sudo apt install python3-gdal 
sudo apt install gdal-bin 

• Make esa-snap gpt available on PATH 
Assuming esa-snap is installed in /opt/esa-snap 
this can be done by adding these lines to ~/.bashrc 
if [ -d "/opt/esa-snap/bin" ] ; then 
  PATH="/opt/esa-snap/bin:$PATH" 
fi 

2.3.  Download and installation  

!!  Important note: I f  you have already previous version of SNAP and/or ICOR 

instal led,  it  is  important to ful ly uninstal l  and remove these older SNAP and 

ICOR versions before starting the instal lations.  

Instal lation on WINDOWS  

Run  iCOR_Setup_3.1.0.exe 

Please note that it can take a few minutes before the installation process starts.  

A new window will pop-up with the iCOR Setup installation wizard. 

If you have no administrative privileges some steps are skipped, also see “Non default 

installation path” further below in this document for needed changes. 

➔ “Select install mode” → “Install for all users (recommended)” 
➔ “Do you want to allow this app from an unknown publisher to make changes to your 

device” → “Yes” 
➔ Go through the installation by selecting “I accept the agreement” 
➔ Choose the installation folder (by default: ‘C:\Program Files\VITO\iCOR-3.1.0‘)  

If you change this see “Non default installation path” further below in this document for 
needed changes. 
→ “Next” → ”Install” 

➔ “Finish” 
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Instal lation on LINUX Ubuntu  

Run icor_install_ubuntu_24_04_x64_3.1.0.bin with a user that has permissions to write to /opt 

or by using sudo 

Please note that it can take a few minutes before the installation process starts.  

sudo ./icor_install_ubuntu_24_04_x64_3.1.0.bin 
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This should result in the following output: 

[sudo] password for <username>: 

Verifying archive integrity...  100%   MD5 checksums are OK. All good. 

Uncompressing iCOR installer Ubuntu 24.04 x64 3.1.0  100% 

Copying iCOR files into the installation folder : /opt/vito/icor-3.1.0 

Done 

iCOR installation for SNAP finished 

 

Opening the plugin in SNAP 

 

If the tool is successfully installed, you need to provide the installation path to SNAP. Therefore, 

in the SNAP toolbox go to Tools → Plugins → Downloaded → Add Plugins.  Browse to the 

directory where the iCOR files where installed, under the subdir ‘sta’ and select the file → click 

on Open. For Windows: 

- iCOR-landsat8-sta-3.1.0-WINDOWS.nbm    

- iCOR-sentinel2-sta-3.1.0-WINDOWS.nbm 

- iCOR-sentinel3-sta-3.1.0-WINDOWS.nbm 

The default directory for these files is: C:\Program Files\VITO\iCOR-3.1.0\sta or 

C:\Users\<username>\AppData\Local\Programs\VITO\iCOR-3.1.0 

For Linux: 

- iCOR-landsat8-sta-3.1.0-LINUX.nbm  

- iCOR-sentinel2-sta-3.1.0-LINUX.nbm 

- iCOR-sentinel3-sta-3.1.0-LINUX.nbm 

The default directory for these files is: /opt/vito/icor-3.1.0.sta 

 

Select both plugins (iCOR-landsat8-sta and iCOR-sentinel2-sta) and press on Install → Next → 

Select ‘I accept the terms in the License Agreement’ → Install.
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A validation Warning might pop-up: 
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Press Continue to continue the installation procedure.  

 

To complete the installation, restart SNAP. 

Non default instal lation path  

If you made adaptations to the installation path of one of the software tools (iCOR on Windows 

by default: C:\Program Files\VITO\iCOR-3.1.0\ non privileged user install by default: 

C:\Users\<username>\AppData\Local\Programs\VITO\iCOR-3.1.0, on Linux by default: 

/opt/vito/icor-3.1.0), you will need to adapt the settings through Tools → Manage External 

Tools. A new window will pop-up where you can highlight which tool you’d like to edit. 

Select “iCOR-SENTINEL-2” and click on the “edit the selected operator” button. 

Navigate to System Variables and adapt the value of “icorinstalldir”. 
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3.  Processors 

When the plugin is loaded in SNAP, the tool can be accessed through Optical → iCOR. There are 

two versions: one for processing Landsat-8 (iCOR-L8) and one for Sentinel-2 (iCOR-S2) data. The 

set-up of both versions is similar, therefore they will be handled simultaneously in the next 

paragraphs. 

 

  

 

 

3.1.  I/O parameters  

The source product refers to the file containing the metadata of the in the  unzipped satellite 

data (Please note that iCOR doesn’t work with zipped files)  i.e. :  

• Landsat-8: *_MTL.txt  

• Sentinel-2 : MTD_MSIL1C found in the *.SAFE folder  

Target product refers to the name of the output product as it will appear in SNAP. You can also 

choose to save the output file as a BEAM-DIMAP format as well , and to open the result 

immediately in SNAP or not.   

Note for Sentinel-2 the DIMAP output is only provided for the 60 m output i.e. the reflectance of 

all bands (except B9 and B10) at 60 m resolution.  
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3.2.  Processing parameters 

 

In the second tab Processing Parameters, you can play and adapt the default parameters. 
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3.3.  Default processing parameters 

This table lists the default processing parameters. Users need to update these parameters 

depending on their needs. For example for water application it is highly recommended to select 

SIMEC adjacency correction and the glint correction.  

ID Parameter Landsat-8 Sentinel-2 

1 Display execution output unchecked unchecked 

2 Target product file C:\Temp\LC8*processed.tif C:\TEMP\S2A*_processed.tif 

3 Working folder C:\Temp\ C:\Temp\ 

4 Keep Intermediate Data false false 

5 Apply user defined gains unchecked unchecked 

6 Generate illumination grids NA false 

7.1 Water detection band  B05 B08 

7.2 Water mask detection threshold 0.05 0.05 

8.1 Cloud detection low band B01 B01 

8.2 Cloud mask low threshold 0.15 0.25 

8.3 Cloud mask average threshold 0.2 0.19 

8.4 Cloud mask include cirrus  Checked checked 

8.5 Cloud mask cirrus threshold 0.005 0.01 

9.1 Estimate AOT checked  checked 

9.2 Aerosol type Rural rural 

9.3 Default AOT value 0.1 0.1 

9.4 Estimate water vapor NA unchecked 

9.5 Default water vapor value 2 2 

10.1 Apply simec correction  unchecked unchecked 
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10.2 Default Adjacency window size 1 1 

11 Glint correction post processing unchecked unchecked 

 

3.4.  Explanation Processing parameters 

1. Display execution output It is advised to check this box. When this box is checked, the 

different steps run through by iCOR are displayed. This helps to check if there was no failure 

in one of the processing steps. A failure might for instance occur when the image based AOT 

retrieval was not able to retrieve AOT values from the scene. 

2. Target product file – Directory & Name of the Geotiff output file  

By clicking on “…” the user can change the output directory and output file name. 

Comment: To deal with the different tiles within a Sentinel-2 image, the final output name 

for Sentinel-2 will consist of 3 Geotiff products  

Example:  

Target product file = C/TEMP/S2A_MSIL1C_*_processed.tif  

Generated output files:  

• S2A_MSIL1C_*_processed.tif : includes the reflectance of all bands (except B9 and 

B10) at 60m resolution  

• S2A_MSIL1C_*_processed_10M.tif : includes the reflectance of B02, B03, B04 and 

B08 at 10m resolution 

• S2A_MSIL1C_*_processed_20M.tif : includes the reflectance of B02,B03,B04,B08 at 

20m resolution  

• S2A_MSIL1C_*_processed_AOT.tif : image retieved AOT values 

• S2A_MSIL1C_*_processed_watermask.tif: generated water mask 

• S2A_MSIL1C_*_processed_cloudmask.tif: generated cloud mask 

 

3. Working folder  

Folder where the intermediate files are stored. These files are removed when the process 

has finished unless the “Keep Intermediate Data” box is checked.  

4. Keep Intermediate Data 
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By checking this option the intermediate files will not be automatically removed when the 

process has finished. 

Please note that the intermediate data size can exceed 10 GB.   

5. Apply user defined gains 

When this box is checked the user defined radiometric gains are applied to the at-sensor 

radiance data prior to the atmospheric correction.   

Users can define the gains by modifying the following files: 

"C:\Program Files\VITO\iCOR\bin\Sensor_LANDSAT8\l8_svc\L8.csv" 

"C:\Program Files\VITO\iCOR\bin\Sensor_Sentinel2\s2_svc\S2A.csv" 

"C:\Program Files\VITO\iCOR\bin\Sensor_Sentinel2\s2_svc\S2B.csv" 

"C:\Program Files\VITO\iCOR\bin\Sensor_Sentinel2\s2_svc\S2C.csv" 

In Sterckx and Wolters (2019) and Bassani and Sterckx (2021) radiometric gains have been 

derived for respectively land and water scenes.  

6. Generate illumination grids 

 

When this option is set to “True” sun-view angle information at pixel level is generated for 

Sentinel-2 and used in the atmospheric correction.  If set to “false” the image averaged sun-

view angles are used.  

Please note that setting the option to “True” will significantly increase the processing time. 

7. Water detection 

The water pixels are detected using a threshold value on a single band.   

7.1. Water detection band– Defies the id of the band used to create a land/water mask.  

7.2. Water detection threshold– Defines the threshold value. If the value is below the 

threshold, the pixel is identified as a water pixel, otherwise it is a land pixel.  

8. Cloud mask 

The cloud mask is created using multiple threshold levels. A pixel is identified as a cloud if it 

fulfils following requirements:  

TOAreflectance Cloud Low BAND ID > ThresholdCloud Mask Low   AND 
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Average_TOAreflectanceVNIRbands > ThresholdCloud Mask Average 

OR if the pixel contains cirrus clouds: 

  TOAreflectancecirrusband > ThresholdCloud Mask Cirrus 

As such, the parameters stand for 

8.1. Cloud detection low band –  Band ID used to check the Cloud Mask Low Threshold 

value.  

8.2. Cloud mask low threshold  Threshold value for the cloud low ID band. If this value is 

exceeded, one of the requirements of defining a cloud pixel is fulfilled. 

8.3. Cloud mask average threshold – Threshold value for the average reflectance in the VIS 

region (0.4 – 0.8 micron, Bands B01 – B04 for Landsat-8 and Bands B01 – B08A for 

Sentinel-2). If this value is exceeded, one of the requirements of defining a cloud pixel 

is fulfilled. 

8.4. Cloud mask include cirrus  – If checked, iCOR includes the cirrus band to optimise the 

cloud mask. 

8.5. Cloud mask cirrus threshold – This threshold defines a pixel as cirrus cloud when the 

threshold value is exceeded 

 

9. Aerosol Optical Thickness 

In iCOR an adapted version of the land based AOT retrieval technique described by Guanter 

et al. (2005b) is implemented. This AOT retrieval algorithm makes use of the spectral 

variability of the land pixels within the image.  

9.1. Estimate AOT – Checking this box enables the image based AOT retrieval 

9.2. Aerosol type – you can choose between rural and desert aerosol  

9.3. Default AOT value – If you know the AOT value, you can choose to uncheck the 

Estimate Aerosol Optical Thickness retrieval and insert the value.  

WARNING: The image based AOT retrieval requires the presence of land pixel and sufficient 

spectral variability in the scene. The image-based AOT retrieval might fail if scene is 

dominated by for instance water, clouds, deserts or snow. In this case a failure message is 

given in the execution window when the “display execution output” is checked. In this case 

the user has to uncheck the “Estimate AOT” (by unchecking the box) and insert of fixed 

value in “Default AOT value” box. 

10. Water vapor  
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10.1. Estimate water vapor This option is only available for Sentinel-2. If this option is 

checked ICOR retrieves the water vapor per pixel from the image itself 

10.2. Default water vapor value The Columnar Water Vapour content of the 

atmosphere, currently only the default value of 2 is available 

11. Adjacency correction  

The spectra of a target pixel can be contaminated by light originating from surrounding 

pixels and atmospherically scattered into the target-sensor path, called adjacency effect (R. 

Richter et al., 2006; Vermote et al., 1997). As a consequence, the overall apparent surface 

contrast decreases as bright pixels will be darkened and dark pixels brightened. iCOR 

contains a module which can correct for these artefacts. For land, adjacency corrections will 

be applied over a fixed range, while over water SIMEC is implemented (SIMilarity 

Environmental Correction (SIMEC), Sterckx et al., 2014). 

11.1. Apply Simec correction  – If checked  the SIMEC adjacency correction will be 

applied over water bodies.  

11.2. Default Adjacency window size  – Over land, instead of SIMEC, adjacency 

effects will be corrected using a fixed range. The extent of this range is given by the 

value defined in this default adjacency window. The units are number of pixels (N). The 

weighted average within the NxN box is considered for the adjacency correction.  When 

N is set to 1, no adjacency correction is applied over land.  

12. Glint correction post processing  It is highly recommended to check this box if you are using 

the images for water-related applications.  

To deal with uncertainties in the Fresnel correction, mainly related to glint and haze effects, 

the minimum value of the water leaving reflectance within bands [B04,B05,B06,B07] of 

Landsat-8 and bands [B04,B05,B06,B07,B08,B8A,B11,B12] of Sentinel-2 is calculated for 

each water pixel, this value is subtracted from the retrieved water leaving reflectance values 

of all spectral bands. 
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3.5.  Output  

The generated output contains Bottom-Of-Atmospheric (BOA) reflectance, which are above 

water water-leaving-reflectance.   

For Landsat-8 one output file is created with a spatial resolution of 30 m.   

 

 

For Sentinel-2, three output files are created for each tile:  

- *.tif – containing the reflectance of all bands (except B9 and B10) at 60 m spatial 

resolution   

 

 

 

- *_20M.tif – only bands with original spatial resolution of 20 m  
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- *_10M.tif – only bands with original spatial resolution of 10 m 
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3.6.  Command line processing  

The best way for running iCOR in batch mode is to first run iCOR through the nominal GUI 

interface with the settings you want to use and to select ‘display execution output’. 

In the beginning of the output window you get something like: 

"C:\Program Files\VITO\iCOR-3.1.0\bin\ python-3.12.10-embed-

amd64\python.exe" "C:\Program Files\VITO\iCOR-3.1.0\src\icor.py" --

sensor S2 --generate_viewing_grids_s2 false --glint_cor false --

keep_intermediate false --apply_gains false --cloud_average_threshold 

0.19 --cloud_low_band B01 --cloud_low_threshold 0.25 --cirrus true --

aot false --aerosol_type RURAL --aot_window_size 100 --simec false --

watervapor false --bg_window 1 --cirrus_threshold 0.01 --aot_override 

0.1 --ozone_override 0.33 --wv_override 2.0 --water_band B08 --

water_threshold 0.05 --working_folder C:\Temp\ --output_file 

C:\Temp\S2C_MSIL1C_20250226T110041_N0511_R094_T30TXR_20250226T130034_pr

ocessed.tif 

C:\dev\vito\S2C_MSIL1C_20250226T110041_N0511_R094_T30TXR_20250226T13003

4.SAFE\MTD_MSIL1C.xml 

You can reuse this line and change the input and output files to run iCOR in batch mode. 

Windows:  

[icor_dir]\icor.bat --sensor S2 --generate_viewing_grids_s2 false --

glint_cor false --keep_intermediate false --apply_gains false --

cloud_average_threshold 0.19 --cloud_low_band B01 --cloud_low_threshold 

0.25 --cirrus true --aot false --aerosol_type RURAL --aot_window_size 

100 --simec false --watervapor false --bg_window 1 --cirrus_threshold 

0.01 --aot_override 0.1 --ozone_override 0.33 --wv_override 2.0 --

water_band B08 --water_threshold 0.05 --working_folder C:\Temp\ --

output_file 

C:\Temp\S2C_MSIL1C_20250226T110041_N0511_R094_T30TXR_20250226T130034_pr

ocessed.tif 

C:\dev\vito\S2C_MSIL1C_20250226T110041_N0511_R094_T30TXR_20250226T13003

4.SAFE\MTD_MSIL1C.xml  

Linux  :  

[icor_dir]/icor.sh --sensor S2 --generate_viewing_grids_s2 false --

glint_cor false --keep_intermediate false --apply_gains false --

cloud_average_threshold 0.19 --cloud_low_band B01 --cloud_low_threshold 
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0.25 --cirrus true --aot false --aerosol_type RURAL --aot_window_size 

100 --simec false --watervapor false --bg_window 1 --cirrus_threshold 

0.01 --aot_override 0.1 --ozone_override 0.33 --wv_override 2.0 --

water_band B08 --water_threshold 0.05 --working_folder /tmp/ --

output_file 

/tmp/S2C_MSIL1C_20250226T110041_N0511_R094_T30TXR_20250226T130034_proce

ssed.tif 

/data/vito/S2C_MSIL1C_20250226T110041_N0511_R094_T30TXR_20250226T130034

.SAFE\MTD_MSIL1C.xml 
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3.7.  Visualisation 

You can now play with the data in SNAP to improve the visualisation: Select the image of 

interest in the Product explorer, go to the Window tab and select Open RGB Image window. A 

new window will pop-up where you can select the appropriate band settings ( A good choice for 

Landsat-8 and Sentinel-2 is: Red – band_4, Green – band_3, Blue – band_2). 

 

  

 

In first instance you might get an image with only black and white colours, since iCOR sets 

invalid pixels at max float. 
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To change this, go to the Colour Manipulation window (View → Tools Windows → Colour 

Manipulation) and change the range of values for the different colour bands (red, green and 

blue). Double click on the value at the end of the colour bar (highlighted in red in the following 

figure) and change to more appropriate values (eg. 0 – 0.5). Press enter.  
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3.1.  Important remarks 

 

The masks generated in iCOR are solely developed to optimize the atmospheric correction and 

do not guarantee optimal performance in different conditions. iCOR does not mask bad pixels, 

and it is advised to look at other sources if a proper mask is needed or wanted.  

iCOR makes use of spectral diversity in land pixels to derive the AOT and to conduct the 

atmospheric corrections. As such, there are situations for which iCOR will not perform well, eg. 

deserts, open oceans (or tiles not including land pixels) or regions fully covered by snow.  

3.2.  Processing time 

iCOR is a computational intensive tool. Consequently, other programmes might run slow 

meanwhile and the required time needed to process one image, depending on the size and 

number of granules, can take a while. For example: one Sentinel-2 granule, without SIMEC 

adjacency correction, might take half an hour. With SIMEC, the whole process will run even 

slower.  

4.  Frequently Asked Questions 

4.1.  iCOR fails to run 

iCOR failure can occur due to different reasons:  

➢ The image-based AOT retrieval might fail if scene is dominated by only water, clouds, 
deserts or snow. In this case a failure message is given in the execution window when the 
display execution output is checked. In this case the user has to disable “Estimate AOT 
from image” (by unchecking the box) and insert of fixed value in ‘AOT override value’ box. 

 

 

 

➢ Paths are not properly defined (See download and installation) 
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➢ Not enough disk space available for processing. iCOR generates during processing a lot of 
intermediate data. It is therefore recommended to have about 20 GB of free disk space 
for running iCOR. 

➢ When failure has occurred, useful information can be derived. when the 

‘keep_intermediate’ option is selected, it is advisable to clean these temp folders 

frequently. Intermediate files are stored into the working folder. 

4.2.  Path does not exist 

You get a Warning “Path does not exist”. 

 

Check Download and Installation especially Non default installation path. 

 

4.3.  Seemingly corrupt output in SNAP 

When opening (automatically after processing or manually) the S2*_processed.tif, this can 

sometimes result in SNAP opening the S2*_processed.tif file with the wrong reader if multiple 

readers are available. 

In that case, close the product and reopen it selecting the “GeoTIFF data product.” reader. 
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4.4.  The result image band is all black 

In first instance you might get an image with only black and white colours, since iCOR sets 

invalid pixels at max float. To change this, go to the Colour Manipulation window (View → Tools 

Windows → Colour Manipulation) and change the range of values. In the Colour Manipulation 

Window → click on “From Data” → change Max: to a more appropriate value (eg. 0.5) and press 

ENTER to confirm. 
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